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Google Slides 
Enter Dates  

Instructor Information 

Instructor  Email  Office Location & Hours  
add text add text  add text 

General Information  

Description 
This course empowers learners to design and deliver clear, engaging presentations using Google Slides. 
Starting with slide creation and layout basics, learners advance to applying themes, inserting images and 
media, formatting text and objects, and using animations and transitions. Collaboration and sharing features 
are also explored to support teamwork and remote presentation needs. Whether building a classroom 
report, business pitch, or training deck, this course helps students, educators, and professionals create 
polished presentations that make an impact. 

Course Objectives 
By the end of this course, learners will be able to:  

 Create, organize, and manage presentations using Google Slides for academic, professional, or 
personal use. 

 Apply themes, background styles, and layout options to create visually consistent slide decks. 

 Insert and format text, shapes, images, charts, audio, video, and Word Art for engaging slide content. 

 Customize object properties including order, alignment, grouping, layering, and animation effects. 

 Structure slides using bullet points, numbered lists, tables, and text formatting to enhance clarity. 

 Manage presentation flow using transitions, speaker notes, and linked slides for effective delivery. 

 Collaborate with others by commenting, sharing access, and managing revision history. 

 Present using tools such as Presenter View, Q&A, and auto-play features for a smooth experience. 

 Print, export, and publish presentations with attention to formatting, compatibility, and audience 
needs. 

Course Materials  

Required materials  
 Computing Device 

 Internet Connection 

Optional materials  
 Headset 
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Schedule  

Dates Unit 

 Unit 1: Environment and Navigation 

 Unit 2: Text Formatting and Tables 

 Unit 3: Working with Images and Objects 

 Unit 4: Themes and Layout Templates 

Course Structure 

The course is structured to learn by doing, practice the learned skill, and then apply the skill. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can understand 
through doing or learning through study materials. Each lesson concludes with a Practice Exercise that 
incorporates the tasks they learned throughout the lesson. Once they have completed the lessons in the 
unit, learners are assessed through a question-based Objective Assessment and a Create Project. 

Weights and Grading 

Add your course weight and grading here 

Additional information and resources  

Add a subheading  
Add text. 
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Instructor Guide Overview 
Course Structure 
The course is structured to learn by doing, practice the learned skill, and then apply the skill. 

• Unit 

o Lesson 

 Learn Tasks 

 Practice Exercises 

 Practice Questions 

o Objective Assessment 

o Create Project 

Each unit contains lessons. The lessons are introduced by lesson topics where learners can 
understand through doing or learning through study materials (eBook, QuickDeck or QuickClip). 
Each lesson concludes with a Practice Exercise that incorporates the tasks they learned 
throughout the lesson. Once they have completed the lessons in the unit, learners are assessed 
through a question-based Objective Assessment and a Create Project. 

Delivery 
The course is created so it can be customized to meet the needs of the instructor and the learner.  

• Direct Instruction:  Utilize the PowerPoint presentations to introduce each lesson topic, 
then have the learners review the study materials and complete the task. 

• Flipped  Classroom:  Learners complete online lessons outside of class time. Learners 
utilize the class time to discuss learned tasks, allow learners to teach concepts, expand 
concepts through learning stations, and work on unit extension or unplugged activities. 

• Learner-Centered Approach: Use the prescriptive learning model so learners can focus 
on new skills and skip the skills they already know. Learners can work at their own pace on 
their own schedule to complete the course. Instructors support learners by utilizing the 
answer keys to identify struggles and guide learners through the solutions.   

Differentiation 
• Study Materials: Study materials are available in eBook, QuickDeck and QuickClip format. 

Each study material provides the same concepts and allows the learners to choose the 
modality that best fits their learning style. The eBook introduces concepts in bite-sized 
readings. QuickDecks display materials in a flashcard format. QuickClips provide a video 
and audio-based clip. 
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• Course Progression: Learners can complete the learn task to demonstrate understanding 
before reviewing the study materials or they can review one or all the study materials 
before attempting the learn tasks. 

• Grouping: Create groups for different learning levels or styles. Customize each group 
setting to best meet the needs of the learners. 

• Learning Resources: These exercises outline what learners need to complete. Learners use 
the eBook, QuickDecks, and QuickClips to study the concept and then apply that 
knowledge to complete the Learn Task. These exercises reinforce independent problem-
solving and help learners demonstrate mastery. 

• Provide struggling learners with answer keys to follow step-by-step instructions to 
complete tasks and exercises. 

• Encourage learners to showcase their newly learned skills by creating additional real-world 
projects, teaching others how and why to use new skills, and exploring beyond their 
learning. 

Prepare for Delivery 
• Begin with the unit overview to understand the structure and flow of the unit, the topics 

covered, the approximate time to complete and the exam objectives reviewed. 

• Review the lesson PowerPoint Presentation to give you an in-depth look at each lesson 
topic and the comprehensive topic notes included. 

• Review the answer keys to familiarize yourself with the tasks learners will complete 
throughout the lesson. 

• Complete the lesson. 

Instructor Resources Overview 
Instructor 
Resources 
File Structure 

 Instructor Resources  
 Course Syllabus 
 Course Overview 
 Course Key Terms 
 Course Instructor Guide 
 Unit 

 Unit Assessment Answer Keys 
 Create Project 
 Objective Assessment  

 Lesson 
 Answer Keys 

 Lesson Practice Exercises 
 Learn Tasks 
 Lesson Practice Questions 

 Study Guides 
 Study Guide Complete 
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 Study Guide Fill-In Explanation 
 Study Guide Fill-In Topic 

 Lesson PowerPoint Presentations 
 Unplugged Activities 
 Unit Overview 
 Unit Learning Plan 
 Unit Key Terms 

 Learner Resources 
Unit Assessment 
Answer Keys 

Each unit includes two types of assessments for learners to apply their 
knowledge. 

• Create Project – These are project prompts and sample solution 
files. Create projects also include “show me” videos for learner 
reference. You have the option to enable/disable this feature. 

• Objective Assessment – A comprehensive question and answer-
based assessment for the unit. Objective Assessments include 
“show solution” for learner reference. You have the option to 
enable/disable this feature. 

Answer Keys 
 

Documents containing answers, step-by-step instructions, and correct 
answers for Instructor reference or to offer additional support material for 
learners. 

• Learn Tasks - Each lesson topic includes an opportunity to apply 
what they have just learned in-app or by answering questions. Learn 
Tasks also include “show me” videos and “show solution” for learner 
reference. 

• Lesson Practice Exercises – End of lesson in-app or scenario-based 
assessment. Lesson Practice Exercises also include “show me” 
videos for learner reference. You have the option to enable/disable 
this feature. 

• Lesson Practice Questions – End of lesson question-based 
assessment. Lesson Practice Questions also include “show solution” 
for learner reference. You have the option to enable/disable this 
feature. 

Study Guides Printable and customizable study guides mapped to lesson topics and 
exam objectives are provided in three formats. 

• Complete- This version includes the topic and the explanation. 
• Fill-In Topic-Learners can fill in the topics as they learn or as a 

review. 
• Fill-In Explanation – This allows learners to complete the 

explanation of each lesson topic in their own words and images. 
Learning Plan Customizable unit learning plan outlining the objectives and topics 

covered, essential questions, learning targets, methods and materials, 
extension activities, formative and summative assessments, mapping to 
STEAM, Work Readiness, 5 C’s, and Bloom’s Taxonomy Levels.  

Lesson 
PowerPoint 

A PowerPoint Presentation that complements the lesson. Each lesson topic 
is included in the presentation as well as comprehensive speaker notes. 

Unplugged 
Activities 

A variety of activities and necessary resources to get learners off the 
computers while still reinforcing unit learning objectives. 
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Unit Key Terms A comprehensive list of key terms throughout the unit. 
Unit Overview A spreadsheet containing the overview of the flow of the unit that includes 

lesson topics, certification objectives mapping, and approximate timings for 
self-paced and instructor-led scenarios. 

Learner 
Resources 

Printable learner resources are available to support learning. Provide these 
files to learners who can benefit from having the learn tasks in printable form 
outside of the XED platform. 
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Google Slides Learning Plan 

Unit 1: Environment and Navigation 
Instructor: Class: Duration: 5-9 hours 
Unit Objectives:  
Learners will understand how to navigate the Google Slides interface, manage slides, and use presentation 
tools to deliver content effectively. 

Essential Questions: 
• How does the layout of Google Slides help users build and present information efficiently? 
• What are the key tools and views that enhance the presentation experience? 
• How can users personalize the presentation workflow and output? 

Learning Targets: 
I will understand how to navigate Google Slides, manage slide content, and use presentation tools 
so I can build and deliver effective presentations. 
I know I succeeded when I can create, organize, present, and configure a Google Slides presentation with 
confidence. 

Methods and Materials: 
• Lectures 
• Reading 
• Videos 
• Hands-on activities 
• Creating 
• Analyzing  
• Discussing 
• Teaching 

Formative Assessments: 
• Learn Tasks 
• Practice Exercise 
• Practice Questions 

 

Summative Assessments: 
• Objective Assessment 
• Create Project 

STEAM 
☒ Science 
☒ Technology 
☒ Engineering 
☒ Art 
☒ Math 

Work Readiness 
☒ Communication 
☒ Problem-solving 
☒ Teamwork 
☒ Work ethic 
☒ Empathy 
☒ Conflict resolution 
☒ Active listening 
☒ Time management 
☒ Adaptability 
☒ Reading 
☒ Mathematics 

5 C’s 
☒ Critical Thinking 
☒ Creativity 
☒ Communication 
☒ Collaboration 
☒ Citizenship 

Blooms Level 
☒ Remembering 
☒ Understanding 
☒ Applying  
☒ Analyzing 
☒ Evaluating  
☒ Creating 
 

Learning Activities 
Domain Time Allowed Content 

Lesson 1: Getting Started 50-100 minutes • Slides Interface 
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• Slideshows 
• AutoSave 
• Know Keyboard Shortcuts 
• Hide Menus 

Lesson 2: Managing Slides 45-85 minutes • Insert a Slide 
• Insert Slides 
• Hide a Slide 
• Change Slides Orientation 

Lesson 3: View and Layout 
Options 

45-85 minutes • Use Grid View 
• Fit Option 
• Select All Slides 
• Print Slides 

Lesson 4:  Slideshow 
Configuration 

55-115 minutes • Slideshow Configuration 
• Set Slide Timings 
• Use Presenter View 
• Navigate a Slideshow 
• Slideshow Tools 
• Slideshow Manipulation 

Lesson 5: Collaboration and 
Comments 

45-85 minutes • Insert/Delete Comments 
• Presentation Distribution 
• Configure Self-Running Presentation 
• Insert Header and Footers 

 

Warm-Up Activities 
1. What’s something you’ve noticed in a really good presentation? Write it down and compare with a partner. 

Talk about whether it had more to do with the slides or how they were used. 
2. On paper, sketch what you think a toolbar should appear like for building a presentation. Include at least 

five icons or buttons. Then discuss which ones were actually available when you explored Google Slides 
previously. 

3. Without using a device, list 3 tasks you’d like to complete faster while using slides. Then guess or make up 
your own keyboard shortcuts. Example: "CTRL + N for a new slide.” 

4. What makes a slideshow good vs. confusing? Make a T-chart listing “Helpful Tools” and “Things That 
Distract.” Share with a neighbor. 

Extension Activities 
1. Create a portfolio for the course. Portfolios should include evidence of work, reflect on learned skills and 

how you can incorporate the skills in a current or future project. This is an ongoing extension activity. 
Continue to add to the portfolio throughout the course. 

2. Select one topic learned throughout the unit then create an instructional video, tutorial, lecture, or hands-
on activity to teach others about the skill. 

3. Design a one-page reference guide that outlines how to use Presenter View, navigate a slideshow, and 
adjust timings. Include space for personal notes during a live presentation. 
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4. Build a professional slide template that a classmate could use for a science project or book report. Make 
sure to set the slide orientation, choose a consistent layout, and include a header or footer with the 
student’s name or class. 

5. Plan out a tutorial that teaches someone how to present using Google Slides. Include steps like starting 
Presenter View, setting slide timings, and navigating with the keyboard. Use boxes and arrows to illustrate 
your flow—like a comic strip! 

 

Unit Evaluation and Reflection 
What went well What needs to change 
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Unit 1 Getting Started Learn Tasks 
Lesson Topic Assessment Details Answer Key File Name 

Slides Interface 1) Open Google Slides. 
2) Change access 

settings to open for 
anyone with the link. 

1) Google.com > Google 
apps icon > Slides 

2) Share button > General 
access section > 
Restricted drop-down > 
Anyone with the link 

 

Slideshows Add two new slides to the 
presentation.   

+ icon OR Use Ctrl + M  Slideshows.pptx 

AutoSave Make sure autosave is 
turned on.   

Cloud/checkmark icon > 
Verify all changes 

 

Know Keyboard 
Shortcuts 

1) Locate the Editing 
Keyboard shortcut for 
define word. 

2) Find the word magma 
on Slide 2 and search 
the definition. 

Ctrl +/ > Editing > magma > 
Ctrl + Shift + Y 

Know Keyboard 
Shortcuts.pptx 

Hide Menus Hide the menus to 
increase design space.  

In the right-side thumbnail 
pane > Upward arrow icon 
OR Ctrl + Shift + F 
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Unit 1 Getting Started Practice Exercise 
Assessment Details Answer Key File Name 

1) Create a new presentation. 
2) Explore the interface by locating 

the menu bar, toolbar, slide 
navigation panel, and work area. 

3) Select the area that displays that 
AutoSave is turned on. 

4) Hide the menu bar to create more 
space, then display it again. 

5) Start the slideshow from the 
beginning to preview your 
presentation. 

6) End the slideshow 
 

1) Open a browser > Go to 
docs.google.com > Launch Google 
Docs 

2) File > New > Presentation 
3) Locate: 

a) Menu bar (top row of commands) 
b) Toolbar (below the menu bar) 
c) Slide navigation panel (left side of 

screen) 
d) Work area (center of screen) 

4) Search for All changes saved in Drive 
at the top to confirm AutoSave is 
enabled. 

5) View > Show menus (toggles to hide 
or show) 

6) Slideshow > Start from beginning 
7) Use Esc key to end the slideshow 
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Unit 1 Getting Started Practice Questions 
 

You’re helping your classmate prepare a group presentation using Google Slides. Your classmate is 
new to Google Slides and keeps asking questions about how to work more efficiently. You offer to 
walk them through the basics and help them get set up. 

 
1) Which part of the Slides interface allows you to view and rearrange all the slides in your 

presentation? 

a) Slide pane (correct) 
b) Toolbar 
c) Comments section 

 
Explanation: The slide pane is located on the left side of the Google Slides interface and displays 
thumbnails of all slides. You can drag and drop slides here to rearrange them. 

 
2) Fill in the blank with the correct word.  

The AutoSave (correct) feature saves your changes automatically, so you don’t have to 
manually save your file. 

• File Recovery 
• AutoSave 
• Slide History 
 
Explanation: AutoSave keeps your work continuously saved to Google Drive, preventing data 
loss even if you forget to manually save. 

 
3) You can use keyboard shortcuts in Google Slides to perform actions more quickly. 

• True (correct) 
• False 
 
Explanation: Keyboard shortcuts like Ctrl + C (Copy) or Ctrl + Z (Undo) allow you to work faster 
without using your mouse. 

 
4) Which menu option allows you to maximize your workspace by hiding the toolbar and 

menus? 

a) File > Page Setup 
b) Tools > Settings 
c) View > Full Screen (correct) 
 
Explanation: The View > Full Screen option hides menus and toolbars to give you more space to 
focus on your slides. 

 
5) Fill in the blank with the correct word.  

When you're ready to present your slides, you can start the slideshow by selecting the Present 
(correct) button in the toolbar. 

• Play 
• Present 
• Display 

 
Explanation: The Present button starts your slideshow from the current or first slide depending 
on the setting. 
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Getting Started
Unit 1: Environment and Navigation
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Slides Interface

• Add animation, narration, 
images, and video

• Modify design with 
themes, templates and 
transitions

• Share with a link or edit 
permissions
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Slideshows

• Present ideas in clear, concise 
and creative manner

• Add new slides with + icon in 
thumbnail panel or Ctrl + M 
(or Cmd + M on a Mac)
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AutoSave

• Slides are saved automatically when online
• To work offline, select the See document status (cloud) 

icon
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Know Keyboard Shortcuts 

• Use combinations of keys 
for productive workflows

• Open a list of shortcuts > 
Ctrl + / (Windows, 
Chrome OS) or Cmd + / 
(Mac)
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Hide Menus

• Declutter your digital workspace by selecting the arrow 
in top right-hand corner
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Unit 1 Getting Started Study Guide 
Complete  

Topic   Explanation   
Slides Interface  
Slides Interface  • Displays main view of presentation.  

• Uses classic menu and shortcut toolbar to customize slides.  
Slideshow Button  • Display slides in Presenter View.  

• Start presentation from beginning.  
• Cast to a different screen.  

Share Button  • Copy link and change access settings.  
• Grant different types of access for specific people.  

Shortcut Toolbar   A collection of shortcuts to features and commands you use 
frequently in Slides.   

Background    The picture or color behind the slide’s content.   

Layout   The way text and images are arranged on a slide.   

Theme   A preset group of colors, fonts, background, and layouts.   

Transitions  The visual effect that occurs when you move from one slide to the 
next during a presentation.  

Slideshows  
Slideshow  Created to present a topic in text and images to a large audience.  

Add New Slides Options  • Select + icon in left-side thumbnail panel.  
• Use Ctrl + M (or Cmd + M on a Mac).  

Quick Tip  Only add one idea per slide.  

AutoSave  
AutoSave  If connected to the internet, presentation is saved automatically in 

Slides.  
Offline Slides Access  Select the See document status (cloud) icon > Turn on.  

Offline   Not being internet-connected and having documents saved to your 
local hard drive.   

Cloud Location  Find the yellow bar with the cloud/checkmark icon.  

Know Keyboard Shortcuts  
Keyboard Shortcuts  A key or combination of keys providing quick access to a particular 

function within a computer program.   
Open List of Keyboard 
Shortcuts  

Ctrl + / (Windows, Chrome OS) or Cmd + / (Mac).   

Hide Menus  
Hide Menus  Select arrow on top-right hand side of Slides to declutter workspace.  
 

21



Unit 1 Getting Started Study Guide  
Fill-In Explanation  

Topic   Explanation   
Slides Interface  
Slides Interface   

Slideshow Button   

Share Button   

Shortcut Toolbar    

Background     

Layout    

Theme    

Transitions   

Slideshows  
Slideshow   

Add New Slides Options   

Quick Tip   

AutoSave  
AutoSave   

Offline Slides Access   

Offline    

Cloud Location   

Know Keyboard Shortcuts  
Keyboard Shortcuts   

Open List of Keyboard 
Shortcuts  

 

Hide Menus  
Hide Menus  
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Unit 1 Getting Started Study Guide  
Fill-In Topic  

Topic   Explanation   
Slides Interface  
 • Displays main view of presentation.  

• Uses classic menu and shortcut toolbar to customize slides.  
 • Display slides in Presenter View.  

• Start presentation from beginning.  
• Cast to a different screen.  

 • Copy link and change access settings.  
• Grant different types of access for specific people.  

 A collection of shortcuts to features and commands you use 
frequently in Slides.   

 The picture or color behind the slide’s content.   
 The way text and images are arranged on a slide.   
 A preset group of colors, fonts, background, and layouts.   
 The visual effect that occurs when you move from one slide to the 

next during a presentation.  
Slideshows  
 Created to present a topic in text and images to a large audience.  
 • Select + icon in left-side thumbnail panel.  

• Use Ctrl + M (or Cmd + M on a Mac).  
 Only add one idea per slide.  

AutoSave  
 If connected to the internet, presentation is saved automatically in 

Slides.  
 Select the See document status (cloud) icon > Turn on.  
 Not being internet-connected and having documents saved to your 

local hard drive.   
 Find the yellow bar with the cloud/checkmark icon.  

Know Keyboard Shortcuts  
 A key or combination of keys providing quick access to a particular 

function within a computer program.   
 Ctrl + / (Windows, Chrome OS) or Cmd + / (Mac).   

Hide Menus   
Select arrow on top-right hand side of Slides to declutter workspace.  
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Unit 1 Create Project 
The Create project is designed to allow the application and demonstration of new knowledge, skills, 
and personal creativity to produce a project-based result while integrating rubric requirements 
using a checklist. 

Tip: While working on your project, remember to save your progress regularly. This will allow you 
to come back to it later. To continue working, open the document, then launch the platform using 
the Add-in whenever you're ready. 

To begin, review the Project Specifications. 

Choose from one of the projects below:  

• My Dream Business pitch presentation: Design a slide deck that introduces your dream 
business. Give it a name, logo, slogan, and brand colors. Include slides for your mission, products 
or services, and a creative “grand opening” announcement.  

• A Top 5 Favorites showcase: Build a fun presentation highlighting your top 5 movies, games, 
books, or artists. Use creative layouts, images, and color themes to match your personality or 
the topic. 

• A Time Travel Adventure story presentation: Turn your slides into a mini story! Choose a time 
period (past or future) and present your adventure using visuals, captions, and transitions. Add 
a map slide or mission summary for extra flair. 

• Your Own Project Proposal: Propose a project idea of your choice to your instructor for approval. 
The goal is to develop a creative and feasible project idea that aligns with the course objectives 
and your interests. 

Complete a presentation using the following as a guide/checklist. 

• Access permissions 
• Keyboard shortcuts 
• Turn on AutoSave 
• Hide menus 
• Insert slides 
• Hide slides 
• Duplicate slides 
• Slide dimensions 
• Slide orientation 
• Slide views 
• Slideshow configuration 
• Slide timings 

• Insert comments 
• Delete comments 
• Headers and Footers 
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Unit 1 Objective Assessment 
 

1) Which part of the Google Slides window contains the slide thumbnails, toolbar, and editing 
canvas? 

a) Slide Master 
b) Slides Interface (correct) 
c) Grid View 
d) Presenter View 
 
Explanation: The Slides Interface includes the thumbnail pane, slide editing area, and toolbar. 

 

2) Which feature allows you to present your slides in full screen with transitions and animations? 

a) Slide Sorter 
b) AutoSave 
c) Slideshow (correct) 
d) Grid View 
 
Explanation: The Slideshow feature launches your presentation in full-screen mode. 

 

3) AutoSave in Google Slides automatically saves your changes as you work. 

• True (correct) 
• False 
 
Explanation: AutoSave is enabled when working on files stored in Google Drive. 

 

4) Which keyboard shortcut inserts a new slide in Google Slides? 

a) Ctrl + M (correct) 
b) Ctrl + N 
c) Ctrl + Shift + N 
d) Ctrl + D 
 
Explanation: Ctrl + M (Cmd + M on Mac) inserts a new slide. 

 

5) What is the benefit of using the Hide Menus option in Google Slides? 

a) Reduces loading time 
b) Prevents changes 
c) Hides formatting options 
d) Maximizes editing space (correct) 
 
Explanation: Hiding menus maximizes space to focus on content editing. 
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6) Fill in the blank with the correct word. 
Use the Insert (correct) menu or the shortcut Ctrl + M to insert a single slide. 

• Insert 
• View 
• Slide 
• Format 
 
Explanation: The Insert menu is used to add new slides. 

 

7) How do you change all slides from landscape to portrait? 

a) Format > Orientation 
b) Slide > Page Setup 
c) File > Page Setup (correct) 
d) View > Rotate 
 
Explanation: File > Page Setup allows orientation changes. 

 

8) Which option exits the Slide Master editing view? 

a) View > Normal 
b) Close Master (correct) 
c) Escape 
d) Return to editing 
 
Explanation: Close Master exits the Slide Master view. 

 

9) What is the purpose of Grid View in Google Slides? 

a) Displays notes 
b) Organizes speaker cues 
c) Displays all slides in thumbnail form (correct) 
d) Enables edit history 
 
Explanation: Grid View displays an overview of all slides. 

 

10) The Fit option adjusts the view so you can ______. 

a) print slides 
b) zoom in 
c) view the full slide in the workspace (correct) 
d) play the slideshow 
 
Explanation: Fit resizes the slide to fully display in your workspace. 

 

11) What happens when you select Ctrl + A while in Grid View? 

a) Align slides 
b) Select all slides (correct) 
c) Add a slide 
d) Apply layout 
 
Explanation: Ctrl + A selects all slides in view. 
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12) To print six slides per page, go to: 

a) File > Download 
b) File > Print settings and preview (correct) 
c) View > Print layout 
d) Insert > Handout 
 
Explanation: File > Print settings and preview lets you print multiple slides per page. 

 

13) Slideshow settings allow you to: 

a) Edit comments 
b) Set transition times (correct) 
c) Format text 
d) Hide slides 
 
Explanation: Slideshow settings are used for timing and playback adjustments. 

 

14) Which setting enables automatic transitions between slides after a set time? 

a) AutoPlay 
b) Slide Timer 
c) Transition Delay 
d) Slideshow Timings (correct) 
 
Explanation: Slideshow Timings control the automatic progression of slides. 

 

15) Presenter View allows the presenter to: 

a) Lock slides 
b) View speaker notes (correct) 
c) Hide menu 
d) Reorder slides 
 
Explanation: Presenter View displays speaker notes and navigation controls. 

 

16) Use the ________ keys to move between slides during a presentation. 

a) Arrow (correct) 
b) Escape 
c) Space 
d) Enter 
 
Explanation: Arrow keys are used to navigate between slides. 

 

17) Which of the following tools is available during a slideshow? 

a) Spell check 
b) Paint format 
c) Laser pointer (correct) 
d) Version history 
 
Explanation: A laser pointer helps highlight content during a live presentation. 
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18) You can loop a slideshow to play continuously. 

• True (correct) 
• False 
 
Explanation: Slideshow settings allow looping options. 

 

19) To suggest a change or leave feedback without editing, use: 

a) Chat 
b) Comments (correct) 
c) Slide Notes 
d) Track Changes 
 
Explanation: Comments allow collaborators to leave suggestions or notes. 

 

20) To distribute your slides without allowing editing, you should: 

a) Publish to the web (correct) 
b) Share with editor access 
c) Enable comments 
d) Use Speaker View 
 
Explanation: Publishing to the web allows view-only access for wide distribution. 

 

21) Which feature allows you to add repeated content to every slide? 

a) Title box 
b) Master layout 
c) Header and Footer (correct) 
d) Table of contents 
 
Explanation: Headers and footers let you apply consistent info to each slide. 
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Unit 1 Key Terms   

Term   Definition   
Background   The picture or color behind your slide's content.  

Configuration  An arrangement of elements in a particular form, figure, or combination.  

Configure  To set up for operation especially in a particular way.  

Grid View  To view all your slides at once, as thumbnails.   

Keyboard Shortcuts  A key or combination of keys providing quick access to a particular function 
within a computer program.  

Layout  The way your text and images are arranged on a slide.  

Manipulation  The skillful handling, controlling or using of something.  

Motion  An act, process, or instance of changing place.  

Navigate  To determine a path or course of your presentation.   

Offline  Not being internet-connected and having documents saved to your local 
hard drive.  

Orientation  Whether the page should be printed horizontally or vertically.   

Placeholder  To temporarily fill content areas until the actual text is ready.  

Print Options  Settings that determine how a document will be printed, including the 
number of copies and page layout.  

Queue  A list of slides, stored, to be retrievable in a definite order.  

Restricted  Giving a user limited access or scope to a file.  

Shortcut Toolbar  A collection of shortcuts to features and commands you use frequently in 
Slides.  

Skip  To pass over without notice or mention.  

Theme  A preset group of colors, fonts, background, and layouts.  

Transitions  The visual effect that occurs when you move from one slide to the next 
during a presentation.  

Version  A saved slideshow differing in certain respects from an earlier form.  
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Unit 1: Unplugged Activities 
Instructor Guide 
  

Instructions 
Below are a variety of offline activities to choose from to support learning in the unit. Choose activities 
to enhance learning in the classroom.  

Activity 1: Word Search 
With Words - Use this word search to reinforce the key terms in the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms in the unit using clues. An 
answer key is provided. 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answers with key terms from the unit.  A 
solution key is provided. 

Activity 3: Build a Deck Card Game 
Learners will simulate building and customizing a Google Slides presentation using a hands-on card 
game. By organizing, modifying, and presenting a deck of slide cards, learners will learn what each 
feature does and when to use it. 

Activity 4: Slide Show Showdown  
Learners will use printed slide cards to simulate creating, editing, and navigating a slideshow. This 
activity helps practice managing slides and thinking critically about how a presentation should be 
structured and delivered. 
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Unit 1 Unplugged Activity 
 

Activity 1: Word Search   

With Words - Use this word search to reinforce the key terms from the unit. An answer key is provided.  

With Clues - Use this word search to challenge learners to find key terms from the unit using clues. 
An answer key is provided. 
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Unit 1 Word Search with Words 
Complete the following word search by finding and circling all the words in the box below the puzzle. 
Words can be in any direction.  

 

BACKGROUND   
CONFIGURATION  
CONFIGURE  
GRIDVIEW  
SKIP  

KEYBOARDSHORTCUTS  
LAYOUT  
MANIPULATION  
MOTION  
THEME  

NAVIGATE  
OFFLINE  
ORIENTATION  
PLACEHOLDER 
TRANSITIONS 
 

PRINTOPTIONS  
QUEUE  
RESTRICTED 
SHORTCUTTOOLBAR 
VERSION 

S D S I S O V Y Z J M N U Q U E U E B Q W
H U D X R K A C L M S W U N A V I G A T E
O H U L D W A O R V B O M L O X K O S F U
R M O H O K N N L O V X M G L S T L I B Q
T R A M H H Z F D N O R I E N T A T I O N
C P N O I J G I A J M K Z O V I Q W K D G
U L R C A P K G S B D O I Y T I S B E T Z
T A N R U P M U C G T T F T D P A T N Q B
T D S L L E B R W D I B S F N C C L R C P
O Z Y K X W C E N S L N T O L I M E H R H
O S F W I K R U N W O D I E R I D A A O Y
L B A Z E P O A B I P T S T R L N K H I T
B R N X W R R W T T A B S N O W N E J C W
A K U G G T D P A L L E O H I L A Y O U T
R F A K S P O Q U A R I E G R I D V I E W
G U C Q D T B P O A S C P K M L K Q X T M
Z A C O N F I G U R A T I O N O R B M H X
B J S I W N V H E L E Z T L D E T R Z E S
M E R Y A N R V P F R K F I C K H I Z M U
W P Q M H S V J T Y E W G W V A N G O E Y
K E Y B O A R D S H O R T C U T S Q S N N
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Unit 1 Word Search Solution Key 

 
 

 

 

S D S I S O V Y Z J M N U Q U E U E B Q W
H U D X R K A C L M S W U N A V I G A T E
O H U L D W A O R V B O M L O X K O S F U
R M O H O K N N L O V X M G L S T L I B Q
T R A M H H Z F D N O R I E N T A T I O N
C P N O I J G I A J M K Z O V I Q W K D G
U L R C A P K G S B D O I Y T I S B E T Z
T A N R U P M U C G T T F T D P A T N Q B
T D S L L E B R W D I B S F N C C L R C P
O Z Y K X W C E N S L N T O L I M E H R H
O S F W I K R U N W O D I E R I D A A O Y
L B A Z E P O A B I P T S T R L N K H I T
B R N X W R R W T T A B S N O W N E J C W
A K U G G T D P A L L E O H I L A Y O U T
R F A K S P O Q U A R I E G R I D V I E W
G U C Q D T B P O A S C P K M L K Q X T M
Z A C O N F I G U R A T I O N O R B M H X
B J S I W N V H E L E Z T L D E T R Z E S
M E R Y A N R V P F R K F I C K H I Z M U
W P Q M H S V J T Y E W G W V A N G O E Y
K E Y B O A R D S H O R T C U T S Q S N N
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Unit 1 Word Search with Clues 
Complete the following word search by finding and circling the words that fit the clues below. Words can 
be in any direction.  

 

 
  

S D S I S O V Y Z J M N U Q U E U E B Q W
H U D X R K A C L M S W U N A V I G A T E
O H U L D W A O R V B O M L O X K O S F U
R M O H O K N N L O V X M G L S T L I B Q
T R A M H H Z F D N O R I E N T A T I O N
C P N O I J G I A J M K Z O V I Q W K D G
U L R C A P K G S B D O I Y T I S B E T Z
T A N R U P M U C G T T F T D P A T N Q B
T D S L L E B R W D I B S F N C C L R C P
O Z Y K X W C E N S L N T O L I M E H R H
O S F W I K R U N W O D I E R I D A A O Y
L B A Z E P O A B I P T S T R L N K H I T
B R N X W R R W T T A B S N O W N E J C W
A K U G G T D P A L L E O H I L A Y O U T
R F A K S P O Q U A R I E G R I D V I E W
G U C Q D T B P O A S C P K M L K Q X T M
Z A C O N F I G U R A T I O N O R B M H X
B J S I W N V H E L E Z T L D E T R Z E S
M E R Y A N R V P F R K F I C K H I Z M U
W P Q M H S V J T Y E W G W V A N G O E Y
K E Y B O A R D S H O R T C U T S Q S N N
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Unit 1 Word Search Clues 

WORD CLUE 

 The picture or color behind your slide's content.  

 An arrangement of elements in a particular form, figure, or combination.  

 To set up for operation especially in a particular way.  

 To view all your slides at once, as thumbnails.   

 A key or combination of keys providing quick access to a particular function within 
a computer program.  

 The way your text and images are arranged on a slide.  

 The skillful handling, controlling or using of something.  

 An act, process, or instance of changing place.  

 To determine a path or course of your presentation.   

 Not being internet-connected and having documents saved to your local hard drive.  

 Whether the page should be printed horizontally or vertically.   

 To temporarily fill content areas until the actual text is ready.  

 Settings that determine how a document will be printed, including the number of 
copies and page layout.  

 A list of slides, stored, to be retrievable in a definite order.  

 Giving a user limited access or scope to a file.  

 A collection of shortcuts to features and commands you use frequently in Slides.  

 To pass over without notice or mention.  

 A preset group of colors, fonts, background, and layouts.  

 The visual effect that occurs when you move from one slide to the next during a 
presentation.  

 A saved slideshow differing in certain respects from an earlier form.  
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Unit 1 Word Search with Clues Answer Key 
WORD CLUE 
BACKGROUND   The picture or color behind your slide's content.  
CONFIGURATION  An arrangement of elements in a particular form, figure, or combination.  
CONFIGURE  To set up for operation especially in a particular way.  
GRIDVIEW  To view all your slides at once, as thumbnails.   
KEYBOARD 
SHORTCUTS  

A key or combination of keys providing quick access to a particular function within 
a computer program.  

LAYOUT  The way your text and images are arranged on a slide.  
MANIPULATION  The skillful handling, controlling or using of something.  
MOTION  An act, process, or instance of changing place.  
NAVIGATE  To determine a path or course of your presentation.   
OFFLINE  Not being internet-connected and having documents saved to your local hard 

drive.  
ORIENTATION  Whether the page should be printed horizontally or vertically.   
PLACEHOLDER  To temporarily fill content areas until the actual text is ready.  
PRINT OPTIONS  Settings that determine how a document will be printed, including the number of 

copies and page layout.  
QUEUE  A list of slides, stored, to be retrievable in a definite order.  
RESTRICTED  Giving a user limited access or scope to a file.  
SHORTCUT 
TOOLBAR  

A collection of shortcuts to features and commands you use frequently in Slides.  

SKIP  To pass over without notice or mention.  
THEME  A preset group of colors, fonts, background, and layouts.  
TRANSITIONS  The visual effect that occurs when you move from one slide to the next during a 

presentation.  
VERSION  A saved slideshow differing in certain respects from an earlier form.  
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Unit 1 Unplugged Activity 
 

Activity 2: Crossword Puzzle 
Solve the crossword puzzle by reading clues and filling in the answer with key terms from the unit.  An 
answer key is provided. 
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Unit 1 Crossword Puzzle 
 
Use the clues to solve the crossword puzzle. 
 

 
 
 
 
 
 
 
 
 

1

2 3

4 5 6

7 8 9 10

11

12

13

14

15

16 17

18

19
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Unit 1 Crossword Clues 
 
Across 
 3 To determine a path or course of your presentation.   (8) 
 4 Giving a user limited access or scope to a file.  (10) 
 8 Not being internet-connected and having documents saved to your local hard drive.  (7) 
 9 To pass over without notice or mention.  (4) 
 11 To set up for operation especially in a particular way.  (9) 
 13 Whether the page should be printed horizontally or vertically.   (11) 
 14 The skillful handling, controlling or using of something.  (12) 
 16 A key or combination of keys providing quick access to a particular function within a computer 

program.  (17) 
 18 A saved slideshow differing in certain respects from an earlier form.  (7) 
 19 An act, process, or instance of changing place.  (6) 
 
Down 
 1 The picture or color behind your slide's content.  (10) 
 2 A list of slides, stored, to be retrievable in a definite order.  (5) 
 5 A collection of shortcuts to features and commands you use frequently in Slides.  (15) 
 6 To temporarily fill content areas until the actual text is ready.  (11) 
 7 To view all your slides at once, as thumbnails.   (8) 
 10 Settings that determine how a document will be printed, including the number of copies and page 

layout.  (12) 
 11 An arrangement of elements in a particular form, figure, or combination.  (13) 
 12 The visual effect that occurs when you move from one slide to the next during a presentation.  (11) 
 15 The way your text and images are arranged on a slide.  (6) 
 17 A preset group of colors, fonts, background, and layouts.  (5) 
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Unit 1 Crossword Puzzle Answer Key 
 

 
 

Across: 3 NAVIGATE, 4 RESTRICTED, 8 OFFLINE, 9 SKIP, 11 CONFIGURE, 13 ORIENTATION, 
14 MANIPULATION, 16 KEYBOARDSHORTCUTS, 18 VERSION, 19 MOTION 

Down: 1 BACKGROUND, 2 QUEUE, 5 SHORTCUTTOOLBAR, 6 PLACEHOLDER, 7 GRIDVIEW, 
10 PRINTOPTIONS, 11 CONFIGURATION, 12 TRANSITIONS, 15 LAYOUT, 17 THEME 

B
1

Q
2

N
3

A V I G A T E

U C

R
4

E S
5

T R I C T E D K P
6

H U G L

G
7

O
8

F F L I N E S
9

K I P
10

R A

R R R O C

I T C
11

O N F I G U R E

D C T
12

O N N H

V U R N T D O

I T A F O L

O
13

R I E N T A T I O N I P D

W O S G T E

O M
14

A N I P U L A T I O N R

L
15

L T R O

A B I A N

K
16

E Y B O A R D S H O R T C U T
17

S

O R N I H

U V
18

E R S I O N E

T N M
19

O T I O N

E
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Unit 1: Unplugged Activity  
 
Activity 3: Build a Deck Card Game 
Objective: Learners will simulate building and customizing a Google Slides presentation using a 
hands-on card game. By organizing, modifying, and presenting a deck of slide cards, learners will 
learn what each feature does and when to use it. 

 

Materials Needed: 

• A set of printed Slide Cards (provided by your teacher or cut out from the packet) 

• A blank paper workspace to “build” your deck 

• Pencil and paper  

 
Instructions: 
• Start by laying out your 6–8 Slide Cards in any order you want. Think of a theme (e.g., a class 

field trip, your dream business, favorite animals). Arrange your cards to match the flow of your 
story or idea. 

• Apply these changes using tokens, symbols, or written labels: 
• Hide one slide (place an “X” in the corner) 
• Change the orientation of one (turn it sideways) 
• Add a header to one slide (write on top of the card) 
• Insert a new slide after slide 2 (draw a new card) 

• Use arrows or numbers to show how you would navigate through the deck in Presenter View. 
Would you skip the hidden slide? Would one slide need more time? Add a star to one slide 
that should stay on screen longer. 

• On a piece of paper, answer: 
• Which feature was most helpful to organize your deck? 
• What did you learn about Presenter View or Slide Timings? 
• If you turned this into a real presentation, what would you add? 
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Slide Cards Template 
Cut out the cards below and use them to build your slide deck. 

Slide 1: _________________________________ 

Notes: __________________________________ 

 
 

Slide 2: _________________________________ 

Notes: __________________________________ 

 
 

Slide 3: _________________________________ 

Notes: __________________________________ 

 
 

Slide 4: _________________________________ 

Notes: __________________________________ 

 
 

Slide 5: _________________________________ 

Notes: __________________________________ 

 
 

Slide 6: _________________________________ 

Notes: __________________________________ 

 
 

Slide 7: _________________________________ 

Notes: __________________________________ 

 
 

Slide 8: _________________________________ 

Notes: __________________________________ 
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Unit 1: Unplugged Activity  
 
Activity 4: Slide Show Showdown 
Objective: Learners will use printed slide cards to simulate creating, editing, and navigating a 
slideshow. This activity helps practice managing slides and thinking critically about how a 
presentation should be structured and delivered. 

Materials Needed: 

• A shuffled set of 8–10 slide title cards 
• A list of slide actions 
• A timer and a challenge board 

 
Instructions: 
• Sort your shuffled slide cards into a logical order to tell a clear story or message. 
• Take turns drawing an 'action card' with tasks like: 

• Insert a new slide between slides 3 and 4 
• Hide slide 2 
• Change slide 5’s orientation to vertical 
• Add a footer to the last slide 
• Select all slides and mark transitions 

• Choose a presenter to walk through your finished slideshow using the cards in order. Narrate 
what each slide says and explain any changes you made. 

• Use this quick checklist to see how well your group did: 
• Slides are in a logical order 
• All action cards were followed correctly 
• Presentation was clear and easy to follow 
• Used at least 3 different slide features (insert, hide, footer, etc.) 

• Reflection Questions: 
• Which action made the biggest change to your presentation and why? 
• What slide features helped make your story clearer? 
• What part of building the slideshow was the most fun or challenging? 

 
 

 

  

 

 

 

 

 

43



Slide Title Cards (Cut-Outs) 
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Google Slides Course Key Terms   

Term   Definition   
Adjustment  A small alteration or movement made to achieve a desired fit, appearance, 

or result.  

Align  To place or arrange (things) in a straight line.  

Alt Text  
Describes the appearance or function of an image on a web page. It is read 
aloud by programs called screen readers which are used by people with 
visual impairments and low vision.  

Arrange  Put (things) in a neat, attractive, or required order.  

Auditory  Having to do with the sense of hearing.  

Background   The picture or color behind your slide's content.  

Blur Radius  The length of the shadow in pixels.   

Bulleted List  A series of items with a heading, and broken up by dotted points, arrows, 
checkboxes, or other types of icons.  

Color Palette  A selection of built-in colors to customize text, backgrounds, shapes, and 
graphical elements.   

Column  A list of values, usually belonging to a particular field, displayed vertically in a 
table.  

Configuration  An arrangement of elements in a particular form, figure, or combination.  

Configure  To set up for operation especially in a particular way.  

Design Process  A strategy that helps you break down large projects into smaller, convenient-
to-handle stages.  

Drop Shadow  A visual effect consisting of a drawing element which appears like the 
shadow of an object.  

Embed  The process of inserting external content directly into your slide 
presentation.  

Equation  
A statement that the values of two mathematical expressions are equal, 
indicated by the Equals sign.  

Font  The specific style of text that's printed on a page or displayed on a computer 
screen.  

Format  Adjust the layout or appearance of elements on the slide.  

Grid View  To view all your slides at once, as thumbnails.   

Group  To gather things together as one object.  

Guide  A structure or marking that helps to position something in a horizontal or 
vertical way.  

Hierarchy  How the Slides adopt their styles, if it’s through their parent settings or 
individually.   
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Hover  To position (a cursor or mouse) over something (such as an image or icon) 
without selecting it.  

Images  Basic pictures and symbols made available to Slides users to add to their 
presentation.  

Indent  Start (a line of text) or position (a block of text, table, etc.) further from the 
margin than the main part of the text.  

Infographic  A visual representation of information or data.  

Italics  A style of writing or printing in which the letters lean to the right.  

Keyboard Shortcuts  A key or combination of keys providing quick access to a particular function 
within a computer program.  

Layout  The way your text and images are arranged on a slide.  

Manipulation  The skillful handling, controlling or using of something.  

Master Template 
Editor  

It allows you to quickly modify the slides and slide layouts in your 
presentation.  

Merge  To combine or cause to combine to form a single entity.  

Motion  An act, process, or instance of changing place.  

Navigate  To determine a path or course of your presentation.   

Numbered List  A series of items sorted alphabetically or numerically.   

Offline  Not being internet-connected and having documents saved to your local 
hard drive.  

Opacity  The condition of lacking transparency or translucence.  

Orientation  Whether the page should be printed horizontally or vertically.   

Paint Format  Quickly apply the same styling, such as color, font style and size, or border 
style, to single or multiple pieces of text or graphics. You can copy all the 
formatting from one object and apply it to another one.  

Pixels  The smallest unit of measurement that makes up a digital display.  

Placeholder  To temporarily fill content areas until the actual text is ready.  

Print Options  Settings that determine how a document will be printed, including the 
number of copies and page layout.  

Properties  A quality, attribute, or distinctive feature of elements offered in Google 
Slides.  

Queue  A list of slides, stored, to be retrievable in a definite order.  

Reflection  The mirrored effect of an image or text, where the original version of the 
object is also viewed in its reversed state.  

Resize  Change the size of an object using the handles of the image (when selected) 
or using the image size properties.   

Restricted  Giving a user limited access or scope to a file.  

Row  A single group of related data listed horizontally within a table.   
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Shape  A page element such as a rectangle, arc, arrow, text box, or other defined 
type of shape.  

Shortcut  A link that points to a computer program or website address.   

Shortcut Toolbar  A collection of shortcuts to features and commands you use frequently in 
Slides.  

Skip  To pass over without notice or mention.  

Slide Master View  Allows you to quickly modify the slides and slide layouts in your 
presentation.  

Stack  A pile of objects, typically one that is neatly arranged.  

Style  
You can set the properties for text which could include Bold, Italic, and 
Underline.  

Synonyms  One of two or more words or expressions of the same language that have 
the same or nearly the same meaning in some or all senses.  

Theme  A preset group of colors, fonts, background, and layouts.  

Transitions  The visual effect that occurs when you move from one slide to the next 
during a presentation.  

Underline  Adds a line under the text to emphasize the information.  

Version  A saved slideshow differing in certain respects from an earlier form.  

Word Art  A gallery of text styles that you can add to your publications to create 
decorative effects, such as shadowed or mirrored (reflected) text.   
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